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~HighpassSharpen™ Gizmo fir Nuke

Nuke lasst sich wunderbar erweitern - mit sogenannten Gizmos. Was das ist und wie man sie einsetzt, zeige ich
Ihnen im im ersten Teil der Workshop-Reihe, wenn wir ein ,HighpassSharpen™ Gizmo bauen.

von Simon Jokuschies

uke stellt primar eine Orgloal

N Vielzahl an Nodes for di-
verse Aufgabenbereiche
zur Verfogung. Diese beinhalten
Operatoren wie beispielsweise
Filter, Keyer, Farbanpassungen,
Transformationen, Deep Com-
positing und vieles mehr. Mit
den gegebenen Nodes ist man
jedoch nicht limitiert, denn das
Compositing-Programm bietet
die Moglichkeit, eigene Nodes
zu erstellen. Hierbei bedient
man sich aus der Menge der
werkseitig vorgegebenen Nodes
und kreiert Effekte durch eige-
ne Node-Verbindungen. Diese
lassen sich als sogenannte Giz-
mos speichern und mit anderen
Nutzern teilen. Dieser dreiteilige —
Workshop (die nachsten bei- | —
den Teile in der DP 02:16 und
03:16) zeigt die Erstellung zweier
Gizmos und die zugehorigen Be-
fehle zur Einbindung dieser in die
Benutzeroberflache von Nuke.
Hierbei entsteht ein eigenes
Gizmo for die Scharfzeichnung
mittels Highpass-Filter sowie ein
selbstkreierter Glow-Effekt.
DasBauenvon Gizmosgliedert
sich in mehrere Arbeitsschritte:
Zunachst werden die Node-
Verbindungen angelegt und die
Nodes in eine Gruppe ausgela-
gert. AnschlieBend werden die

Abb. 1: Aufgesetzt - die Node-Verbindung und das Ergebnis

Highpass Sharpen

eines Highpass-Sharpen-Effekts

entsprechenden Einstellregler,
die sogenannten Knobs, zum
Verandern der Gruppe gewashlt.
Diese Gruppe wird anschlieBend
in ein Gizmo Uberfohrt, welches
sich mithilfe von Python-Befeh-
len in Nukes Benutzeroberfldche
integrieren I3sst.

.HighpassSharpen®
Gizmo

Zum Scharfen von Bildern stellt
Nuke werkseitig den Sharpen
Node zur Verfogung. Die fol-
genden Schritte zeigen, wie man
einen eigenen Node zum Schar-
fen von Bildern durch eine alter-
native Technik kreieren kann. Es
handelt sich um eine Methode, die
das Scharfen mittels Hochpass-
Filter vollzieht (Englisch: High-
pass). Der interessante Aspekt ist
dabei, dass der Weg Uber einen
Highpass-Filter lediglich Bereiche
mit hohem Kontrast, wie etwa
Kanten, in einem Bild scharft. Die
Farbfldchen an sich bleiben wei-
testgehend unbeeinflusst.

Nach dem Importieren des zu
scharfenden Bildes (in diesem
Fall ein Bild des ,Mount Ruape-
hu" - auch bekannt als Schau-
platz for ,Mordor" aus ,Herr der
Ringe") erstellen wir einen Blur
Node, gefolgt von einem In-
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Abb. 2: Verbunden - der Highpass-Sharpen-
Effekt liegt nun Gber dem Originalbild
und fungiert als Scharfungsfilter.

vert Node. Der Blur Node erhdlt im Knob
,Size" einen Wert von ,40" und das Drop-
down-Mend ,Channels" bleibt auf seinem
Standardwert ,RGB". Der Invert Node bleibt
unverandert. Das entstandene Ergebnis [8sst
sich nun mit einem Merge Node im Blen-
ding-Modus ,Average" Uber das Original le-
gen. Diese Operationen resultieren in einem
Highpass-Filter. Mit dieser Technik werden
die kontrastreichen Kanten innerhalb eines
Bildes deutlich, wahrend die Farbflachen
des Bildes in eine graue Fldche Ubergehen
(Abb. 1). Der Highpass-Filter I&sst sich nun
Uber einen weiteren Merge Node mit dem
Original-Bild verbinden. Hierbei findet der
Blending-Modus ,Overlay™ Verwendung.
Nun ist die selbst erstellte Scharfung mittels
Highpass-Filter bereits vollstandig (Abb. 2).

AnschlieBend wird mit einem Matrix
Node eine zusatzliche Scharfung auf das
Bild angewandt. Beim Matrix Node handelt
es sich um eine sogenannte Faltungsmatrix
- wird der resultierende Wert eines Pixels
durch seine angrenzenden Pixel beeinflusst.
Je nachdem, welche Werte in der Matrix ein-
getragen werden, lassen sich unterschied-
liche Ergebnisse - beispielsweise Scharfen,
Weichzeichnen oder Relieferstellungen -
eines Bildes erzeugen.

Fur eine Scharfzeichnung werden die
Werte gemaR Abbildung 3 bendtigt. Um
die Starke des Effekts zu reduzieren, l3sst
sich der Knob ,Mix" auf den Wert ,0.1" ver-
mindern. Hiermit ist die Node-Verbindung
for den eigenen Node zur Scharfzeichnung
komplett (Abb. 4).
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Abb. 4: Fertiggestellt - die vollstandige
Node-Verbindung fir den eigenen
Highpass-Sharpen-Effekt

Abb. 3:
Eingestellt -
mit diesen
Werten dient
der Matrix
Node als
Scharfzeich-
nungsfilter.
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Abb. 5: Uberblick - mit der Funktion ,Split Horizontal*
lasst sich die Benutzeroberflache unterteilen und
beide Node-Verbindungen gleichzeitig anzeigen.

Node-Gruppierung

Als Nachstes wird diese nun in eine Gruppe
ausgelagert, hierfor mussen alle zu gruppie-
renden Nodes selektiert werden. Das scharf
zu zeichnende Bild wird jedoch nicht se-
lektiert, da sich dieses spater variabel Uber
einen Input Node initialisieren lasst. Um
Nodes zu gruppieren mussen Sie diese aus-
wahlen und anschlieBend den Befehl ,Edit
> Node > Group > Collapse To Group™ aus-
fohren; alternativ I13sst sich das TastenkUrzel
.cmd+G" (Mac) beziehungsweise ,Strg+G"
(Windows) verwenden. Beim Erstellen eines
Group Nodes muss feststehen, welcher Node
innerhalb der Gruppe den Ausgang dieser
darstellen soll - dies geschieht durch die
Wahl eines Nodes mit freiliegendem Node-
Ausgang. Sind mehrere freiliegende Node-
Ausgange innerhalb der Gruppe vorhanden,
so wird der Nutzer Uber ein Pop-up-Window
gefragt, welcher Node als Ausgang des Group
Nodes verwendet werden soll.

In unserem Beispiel dient der Matrix1 Node
als Ausgang, daher wahle ich ihn im Drop-
down-Menu aus. Alle Nodes werden darauf-
hin in eine Gruppe zusammengefUhrt und
sind nun nicht mehr im Node Graph sichtbar.
Um diese Nodes anzuzeigen, I3sst sich eine
Gruppe jederzeit 6ffnen.

Hierfor tragt jeder Group Node in seinen
Einstellungen innerhalb des Properties Bin
eine kleine Schaltflache mit der Aufschrift
,S"; alternativ I3sst sich die Node-Verbin-
dung eines Group Nodes durch cmd+Enter
(Mac) beziehungsweise Strg+Enter (Win-
dows) offnen. Um sowohl die Nodes des
aktuellen Nuke-Skripts als auch die Node-
Verbindungen innerhalb eines Group Nodes
parallel anzuzeigen, I8sst sich Uber den Be-
fehl ,Split Horizontal® im Content-MenuU die
Benutzeroberfldche, in der sich der Node
Graph befindet, horizontal teilen. Nun kann
der Node Graph des Group Nodes per Drag-
and-drop in den rechten Bereich gezogen
werden (Abb. 5).
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ren, Loschen und Sortieren dieser (Abb. 7).

E?:sbte?- — Fur die Knobs-Erstellung gibt es in Nuke
lungen - zwei Maglichkeiten: Die Schaltflsche ,Add"
der Group zeigt eine Liste aller in Nuke zur Verfugung
uzgs:;t?; stehenden Knobs (Abb. 8). Auf diese Weise
lediglich font Verdana s - konnen Knobs grundlegend neu erstellt und
I?rt\?)rl‘)ga\:v(:il; hide input ~ cached ~ disable | dope sheet ~ bookmark mit den Kn_ObS der Noqes innerhalb der Grup-
ciein allen postagestamp 1 static frame pe Uber eine Expression verknUpft werden.
anderen il 0 o= e Die zweite Schaltflsche ,Pick..." zeigt ein
Nodesehens export as gizmo...  lock all connections i .

weiteres Fenster, das alle Nodes innerhalb

IEZIJ:“::: ) der Gruppe inklusive ihrer zugehorigen Knobs

Abb. 7: Individualisiert -
das ,Manage User Knobs"-Fenster bietet
zahlreiche Maglichkeiten eigene Knobs zu
erstellen, editieren und zu sortieren.
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Abb. 8: Erstellt - per ,Add“-Methode
Uber die ,,Add“-Schaltflache lassen sich
zahlreiche eigene Knobs kreieren.
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Abb. 9: Ausgewahlt - per ,Pick“-Methode
Uber die ,Pick”-Schaltflache lassen sich Knobs
von Nodes innerhalb der Gruppe auswahlen.

Beim Erstellen des Group Nodes hat Nuke im
Node Graph der Gruppe zwei Nodes auto-
matisch hinzugefogt - ein Input sowie einen
Output Node. Beide sind notwendig, damit
Nuke einen eindeutigen Ein- und Ausgang
for den Group Node zuordnen kann. Der
Input Node reprasentiert den Eingang des
Group Nodes, wahrend der Output Node
den Ausgang widerspiegelt. Ein Group Node
kann zudem weitere Inputs enthalten, diese
lassen sich nachtraglich Uber weitere Input
Nodes hinzufigen. Ein Node kann jedoch
nur einen Output besitzen. Durch das Um-
benennen des Input Nodes in ,src” (for Sour-
ce = Quelle) dndert sich auch die Beschrif-
tung des Inputs des Group Nodes.

Durch das Auslagern der Nodes in eine
Gruppe sind diese nicht mehr im Haupt-
Node-Graph sichtbar, von daher sind auch
ihre Einstellungsmoglichkeiten Uber den
Properties Bin nicht mehr erreichbar. Dies
hat den Nachteil, dass sich Anderungen an
diesen Nodes nur durch das direkte Arbeiten
innerhalb der Gruppe erzielen lassen.

Knobs der Group Nodes

Um dem entgegenzuwirken, kdnnen Sie die
wichtigsten Knobs aller Nodes innerhalb der
Gruppe for den schnelleren Zugriff direkt in
der Einstellung der Group Node im Proper-
ties Bin ablegen. Diese Knobs sind daraufhin
mit den Knobs innerhalb des Group Nodes
verlinkt, wodurch Anderungen direkte Aus-
wirkungen auf die Nodes innerhalb der
Gruppe haben.

Bei den Knobs des Group Nodes finden
sich lediglich Standard-Knobs wieder, die
auch Bestandteil jedes anderen Nodes sind
und sich dort unter dem Tab ,Node" befin-
den. Dies sind Schaltfldchen zum Einstellen
des Labels, der Schriftart, SchriftgréBe und
Farbe (Abb. 6). Eigene Knobs lassen sich
mithilfe des Eintrags ,Manage User Knobs
.. aus dem Menufeld des Nodes hinzufo-
gen. Dieses erscheint beim Rechtsklick im
Properties Bin auf einem leeren Bereich
des Group Nodes. Beim Betatigen kommt
ein neues Fenster zum Vorschein, welches
die Knobs des Nodes in einer Liste anzeigt,
sowie Schaltflachen zum Hinzufugen, Editie-

in einer Baumstruktur darstellt (Abb. 9). Fur
den ersten Gizmo konzentrieren wir uns zu-
nachst auf die einfachere Methode ,Pick".

Pick"-Methode

Der Group Node enthdlt einige Knobs, die
den Effekt und die Starke der Scharfzeich-
nung bestimmen: Dies sind die Starke des
Blur1 Nodes zum Erstellen des Highpass-
Filters, die Deckkraft des Merge2 Nodes
zum Uberblenden des Highpass-Filters mit
dem Original sowie die Effektstarke des Ma-
trix1 Nodes fur das nachtragliche Scharfen.
Diese werden der Gruppe hinzugefugt. Im
Fenster ,Pick Knobs to Add", welches Uber
die Schaltflsche ,Pick" zu erreichen ist, wird
von daher als erstes der Size Knob des Blur1
Nodes gewsahlt. Beim Aufklappen von Blurl
sieht man eine Unterstruktur, diese spie-
gelt die Tab-Struktur des Blur Nodes wider.
Da ein Blur Node die zwei Tabs ,Blur* und
.Node" enthalt, sind exakt diese beiden in
der Unterstruktur enthalten. Ein weiterer
Klick auf Blur zeigt alle Knobs, die im Blur
Tab enthalten sind. Mit dem Anwahlen von
,Size® und dem Bestatigen mit ,OK" wird
der Size Knob des Blur1 Nodes der Gruppe
hinzugefigt und automatisch verlinkt. Das
Fenster ,Pick Knobs to Add" wird darauf-
hin selbststandig geschlossen und in dem
Fenster zum Einstellen der Knobs werden
zwei Elemente aufgelistet: Zum einen ein
Element mit der Aufschrift ,User* und eines
mit der Aufschrift ,Size {Blurl.size}" (Abb.
10). Alle selbst erstellten Knobs werden in
dieser Knob-Liste aufgefuhrt. Diese werden
im Properties Bin des Nodes automatisch in
einem neuen Tab mit der Standardaufschrift
LUser" abgelegt.

Mit dem Anwahlen dieses Eintrags und
dem Klicken auf die Schaltflsche ,Edit" er-
scheint ein neues Fenster zum Editieren der
Schaltflache. Die Aufschrift wird von ,User"
in ,HighpassSharpen" geadndert. Zum An-
dern des Namens stehen zwei unterschied-
liche Elemente zur Verfogung: Der Bereich
.Name" reprasentiert den Namen des Knobs,
der intern verwendet wird, um ihn Uber Py-
thon und Expressions adressieren zu kdnnen.
Der Bereich ,Label" stellt die Aufschrift des
Knobs dar, wie er in der Benutzeroberflache
erscheint. In diesem Beispiel ist eine Ver-
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Abb.10: Individualisiert - der Group Node enthalt nun
den ersten eigens erstellten Knob, der mit dem Size Knob

des internen Blurl Nodes verknipft i
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Abb. 11: Verknipft - der Size Knob des Group Nodes ist nun mit dem
Size Knob des Blurl Nodes verbunden. Beim Andern eines dieser Werte
andert sich der andere Wert automatisch.

fringe

wendung von ,HighpassSharpen® in
beiden Eintrégen adaquat. Die Knob-
Liste reprasentiert diese neuen Wer-
te nun ebenfalls. Das ,Label" - also
der Name, so wie er in der Benutzer-
oberflache erscheint - steht in Klam-
mern, wahrend der interne Name
rechts daneben auftaucht; gefolgt von
dem Knob, auf welchen innerhalb des
Group Nodes verlinkt wird (vgl. Abb.
12 linkes Fenster).

Da die Aufschrift ,Size" des zwei-
ten Knobs for den Benutzer wenig Aussage-
kraft besitzt, wird diese kurzerhand fur die
Benutzeroberflache, also dem Label, in ,Blur
Size" geandert. Durch die Methode ,Pick .."
ist der Blur Size Knob nun mit dem Size
Knob des Blurl Nodes innerhalb der Grup-
pe verlinkt. Beim Andern einer dieser Knobs
passt sich der andere Knob gleichzeitig an
den gleichen Wert an (Abb. 11). Das Erstel-
len eigener Knobs in den Einstellungen des
Group Nodes ermaoglicht es, auf die Knobs
innerhalb der Gruppe Einfluss zu nehmen,
ohne in die Gruppe navigieren zu mussen.
Die Einstellungen der wichtigsten Knobs las-
sen sich nun direkt Uber die Eigenschaften
des Group Nodes vornehmen.

Als Nachstes wird mit dem Bereitstellen
des Mix Knobs von dem Merge2 Nodes die
Deckkraft des Highpass-Sharpen-Effekts ge-
regelt. Von daher wird dieser Knob ebenfalls
Uber die Schaltflsche ,Pick" in der Baum-
struktur der Gruppe aus ,Merge2" ausge-
wahlt. Im Label erhdlt der Knob den aussa-
gekraftigeren Namen ,HighpassMix" - dieser
Knob ist nun mit dem Mix Knob des Merge2
Nodes innerhalb der Gruppe verknopft.

Als Letztes fehlt noch die Effektstarke
des Matrix1 Nodes. Von daher wahlen wir
den Mix Knob des Matrix1 Nodes ebenfalls
aus der Baumstruktur und geben ihm den

HighpassSharpen .. .............
[blur size] size {Biuri.size}

[highpass mix] mix {Merge2.mix}
unnamed

[post sharpen] matrix_mix {Matrix1.mix}

HighpassSharpen1 ]

HighpassSharpen  Node
blur size 40

highpass mix 1

post sharpen 0.1

Cancel

Abb.12: Komplettiert - der fertiggestellte eigene ,HighpassSharpen” Node mit all seinen Knobs

aussagekraftigeren Namen ,PostSharpen®.
Die Gruppe enthalt nun drei Knobs: Die ers-
ten beiden haben direkten Einfluss auf den
Highpass-Sharpen-Effekt. Um diese vom
Post Sharpen Knob visuell zu trennen, kon-
nen Sie Uber den Befehl ,Add" das Element
,Divider Line" hinzufogen. Durch Auswahlen
dieses Elements in der Liste und dem Bets-
tigen der ,Up"- und ,Down"-Schaltflachen
|asst sich das ,Divider Line®-Element zwi-
schen dem Highpass Mix und dem Post Shar-
pen Knob positionieren. Im letzten Schritt
wird der Group Node in ,HighpassSharpen®
umbenannt und blau eingefarbt. Hierdurch
ist die Gruppe vollstandig und bereit for den
Export (Abb. 12).

Group Node als Gizmo

Gegenwartig stellt der Group Node lediglich
ein Node innerhalb des aktuellen Nuke-
Scripts dar. Um den Group Node mit anderen
Nutzern zu teilen und in andere Nuke-Skripte
zu integrieren, muss dieser in ein Gizmo kon-
vertiert werden. Ein Gizmo entspricht einem
Abbild der Gruppe mit all seinen aktuellen
Werten, jedoch als eigenstandige Datei mit
der Dateiendung ,gizmo". Jeder Group Node

tragt im Tab ,Node" eine Schaltflsche mit
der Aufschrift ,Export as Gizmo...". Beim
Betatigen dieser Schaltflache erscheint ein
Dialog zum Auswahlen des Namens und des
Ortes auf der Festplatte. Der Gizmo wird
zunachst als ,HighpassSharpen.gizmo® auf
dem Desktop abgespeichert. Bereits jetzt
kann dieser Gizmo in andere Nuke-Skripte
Uber den Befehl ,File > Insert Comp Nodes"
(Nuke 9), beziehungsweise ,File > Import
Script® (Nuke 8) integriert werden.

In Teil 3 des Workshops zeige ich lhnen,
wie er in die Benutzeroberfldche von Nuke
integriert wird und in Teil 2 der nachsten
DP-Ausgabe erklare ich, wie Sie Ihr eigenes
,Glow" Gizmo kreieren. >mf
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